
 

 
May 2, 2008 
By: Jim Potter, Director of University Relations 
 
Pow Wow 

 
The Sweetgrass Society’s held their 32nd annual Pow Wow last weekend in the Armory Gymnasium. It was an 
excellent event for the tribal communities, campus and community.  The administration would like to extend a 
special thanks to the Sweegrass Society and their advisors Stacey Gonsalez and Jaakko Puisto for all their hard 
work.  Stacey Gonsalez commented, “We had an excellent turn out with about 1,500 in attendance on Saturday 
and a lot of dancers.  I want to personally thank Rolf Groseth, Joe Callahan, and Sue and Alan Ost for all their 
volunteer work and for everyone on campus who worked so hard to make the event run so smoothly.” 
 
 



Tyson Thivierge Named New Head Wrestling Coach 
Montana State University – Northern Athletic Director Mark Samson is proud to announce that Tyson 
Thivierge has accepted the Head Wrestling Coaching position.  Tyson will start his coaching duties 
immediately.  Athletic Director Mark Samson says “Tyson is a great fit for our wrestling program and the 
Havre community.  We are very pleased to have Tyson joining our staff at MSU-Northern”.  Tyson is currently 
the head coach at Carson City High School in Carson City, Nevada.  Tyson and his wife Stephanie have two 
children Orion and Marlee.  Tyson holds a Physical Education degree from MSU-Northern and a 4X All-
American Wrestler for the Lights (1999 3rd, 2000 2nd, 2001 3rd, 2002 National Champion. “This has been my 
dream and my family and I are very excited, we love Havre and we can’t wait get up there.” 
 
End of the Year Parties 

 
The campus was full of parties this week as the campus celebrated the completion of another school year.  Pam 
Conatser even celebrated her “29”th birthday again.  Way to go Pam. 
 
New Mascot for Northern 
The MSU-Northern Student Senate is please to announce the establishment of a Polar Bear as Northern’s new 
mascot.  Students submitted their ideas for a mascot and those suggestions were voted on last week during the 
regular senate elections.  Returning Student Senate President, Kristiny Lorett commented, “I am very pleased 
that we were able to establish a mascot this year.  It is our plan to spend the summer producing the artwork and 
costumes for our Mascot(s) so we can officially present them this fall during Homecoming and Festival Days. 
 
 



Finals Schedule 
            Class is on M W F at: ........................................................ Final is:  
            8:00 - 8:50....................................................... Monday 10:00 - 11:50    
            9:00 - 9:50....................................................... Tuesday 10:00 - 11:50    
            10:00 - 10:50............................................ Wednesday   10:00 - 11:50    
            11:00 - 11:50.................................................. Thursday 10:00 - 11:50    
            12:00 - 12:50....................................................... Monday 1:00 - 2:50    
            1:00 - 1:50........................................................... Tuesday 1:00 - 2:50    
            2:00 - 2:50...................................................... Wednesday 1:00 - 2:50    
            3:00 - 3:50.......................................................... Thursday 1:00 - 2:50    
            4:00 - 4:50............................................................. Monday 3:00-4:50    
     
            Class is on T Th at:............................................................. Final is:  
            8:00 - 9:15............................................................. Tuesday 3:00-4:50    
            9:30 - 10:45...................................................... Wednesday 3:00-4:50    
            11:00 - 12:15....................................................... Monday 8:00 - 9:50    
            12:30 - 1:45......................................................... Tuesday 8:00 - 9:50    
            2:00 - 3:15 ..................................................... Wednesday 8:00 - 9:50    
            3:30 - 4:45.......................................................... Thursday 8:00 - 9:50    
             
Final Exams for Evening Classes are given during their regular class meeting times. 
Alternate Final Times are on Friday, 8:00 - 9:50 and 10:00 - 11:50 
 
Founders’ Excellence Winners 
A special graduation week event, Founders’ Day at Montana State University-Northern, recognizes and honors 
individuals who promote the ideals of service and excellence.  This is a special time when alumni, friends, 
faculty, and students gather to rekindle the spirit of campus life and pause to reflect upon the people, places, and 
events that have helped create an environment for lifetime learning and participation in the Northern tradition. 
 
MSU-Northern Founders’ Excellence Awards will be presented to Tony Preite and Greg Jergeson.  They have 
received outstanding recognition within their own professional fields and/or contributed to the growth and 
development of the campus.   
The presentations will take place during the Founders’ Excellence Dinner Friday, May 9th, 2008 in the Student 
Union Building Dining Room at 7:00 p.m.  Tickets for this prestigious event are $20.00 a person and are 
available through the MSU-Northern Foundation by calling 265-3711 and must be purchased by 4:00 p.m. on 
Thursday May 1st. 
 
Cash for books!  
All next week from 8 a.m. – 1 p.m. you can sell your text books back to the Bookstore! (Receipts are required) 
Bring all the supplemental material that came with your books, sometimes it gets you more money.  A list of 
prices is posted outside the Bookstore.  For more information call 265-3728 or e-mail: bookstore@msun.edu  
 
 
 
 
 
 



 
New Campus Courtyard Clock  

 
The foundation is being built for the new clock that will sit in the center of campus courtyard.  This clock has 
been graciously donated by the Havre Rotary Club and represents the culmination of several years of 
fundraising.  It will become a focal point for the new campus courtyard.  We hope to have it in place for the 
Board of Regents meeting which will take place on our campus at the end of May. 
 
Summer Hours 
The Chancellor has approved that MSU-Northern will again observe Summer Hours beginning May 12th.  
Summer hours will be from 7:30-4:00 with a ½ hour lunch period.  Of course this is at the discretion of each 
office/department and should be arranged with each supervisor.   Please be sure to put signs on your doors and 
change your voice mail messages to reflect summer hours.  The summer hours will end on August 22. 
 
Northern Honors 159 Years of Service 

 



This past Wednesday we honored the people who are retiring or are leaving Northern this year.  Not everyone 
who retired or has left Northern was able to attend.  The honorees that were able to attend included (L to R) 
Mark Allen, Robert “Bob” Christeck  1977-2008  (31 years) Diana Huestis 1980-2008  (28 years) Terry 
Munson 1989-2008  (19 years) Lloyd Stallkamp 1988-2008  (20 years) Jim Longin 2006-2008  (2 years) Debra 
Letra, Robert “Bob” Miller 1973-2008  (37 years)  Gene Corner 1986-2008  (22 years) 
 
Our retirees for this year total some 159 years of knowledge and work experience at MSUN. 
 

Bookstore Open During Graduation 
The Northern Bookstore will be open from 10 a.m. - 2 on May 10th for people from out of town who are 
attending the ceremonies and might want to purchase some Northern memorabilia.  
 
Blood Drives 
There will be two American Red Cross Blood drives next week: Monday, May 5th from 11AM to 5 PM at St. 
Jude Parish Center Wednesday, May 7th   from 11 AM to 3 PM at Northern Montana Hospital 3rd Floor Conf. 
Rooms.  As usual, those wishing to make an appt. may call 1-800-GIVELIF. 
 
Summer Schedule 
If you are looking to register for summer workshops or classes than please go to the Northern web site 
(www.msun.edu) and click on the sun in the bottom right corner.  It will take you to the schedule and it will 
explain how to register.  Printed schedules are available at the Registrar’s office. 
 
Voter Registration Cards in Library 
Want to get involved and vote in the Primary and General Elections?  The Library has voter registration cards at 
the Circulation Desk.  Return the card to your County Clerk & Recorder’s Office by 5:00 PM on May 5th to vote 
in the Primary. 
 
Divorce Southern Style – Last Chance 

 



Once again MAT has produced a side-splitting comedy suitable for all ages by Jennifer Jarrett titled Divorce 
Southern Style.  Pam Vies does an outstanding job playing the lead role of Eleanor Bander.  Included in the 
comedy are uproarious scenes involving her optometrist (played by Northern’s own Joel Soiseth) who is 
pursuing Eleanor and her alcoholic best friend, Alma Lou, (played by Lena Lamphier) a well-known novelist.   
The play will run from April 23-26 and April 30-May 3. Shows nightly at 8:00 p.m. Doors and lounge open at 
7:30 p.m. Tickets are available at the door and are $10/adult and $8/student & Seniors.  MSU-N Students are 
free with ID. 
 
May is “Motorcycle Safety Awareness Month” 
Every year more and more Montanans ride motorcycles and May is “Motorcycle Safety Awareness Month”. It 
is a month to not only remind motorcyclists to ride free of alcohol and drugs, wear protective gear, and ride 
within their skill level, but it is also a time to remind car and truck drivers to be mindful of motorcycles and 
always watch out for motorcyclists. 
 
In Montana we have seen an increase in both motorcycles crashes and fatalities. Motorcyclists are unprotected 
when they collide with a car. There are no doors or windows to protect them. A motorcyclist becomes a 
projectile that will eventually impact with something, whether it is the road, a vehicle or a telephone pole.  
 
Here are a few tips from the Motorcycle Safety Foundation on what you can do to keep motorcyclists safe on 
our streets and highways. 
 
QUICK TIPS: Six Things All Car & Truck Drivers Should Know About Motorcycles  
 
1. When a motorcycle is in motion, don't think of it as motorcycle; think of it as a person. 
 
2. There are a lot more cars and trucks than motorcycles on the road, and some drivers don't "recognize" a 
motorcycle; they ignore it (usually unintentionally). Look for motorcycles, especially when checking traffic at 
intersections.  
 
3. Because of its small size, a motorcycle may look farther away than it is. It may also be difficult to judge a 
motorcycle’s speed. When checking traffic to turn at an intersection or into (or out of) a driveway, predict a 
motorcycle is closer than it looks.  
 
4. Because of its small size, a motorcycle can be easily hidden in a car’s blind spots (door/roof pillars) or 
masked by objects or backgrounds outside a car (bushes, fences, bridges, etc). Take an extra moment to 
thoroughly check traffic, whether you're changing lanes or turning at intersections.  
 
5. Motorcyclists often adjust positions within a lane to be seen more easily and to minimize the effects of road 
debris, passing vehicles, and wind. Understand that motorcyclists adjust lane position for a purpose, not to be 
reckless or show off or to allow you to share the lane with them.  
 
6. Stopping distance for motorcycles is nearly the same as for cars, but slippery pavement makes stopping 
quickly difficult. Allow more following distance behind a motorcycle because it can't always stop "on a dime."  
 
www.msf-usa.org 4/05 
 
Every Montanan, whether or not they ride a motorcycle, needs to do their part in keeping everyone on our roads 
safe. Always remember, you never know who’s under the helmet. 
 
 



Library Corner 
THE MSU-NORTHERN LIBRARY HOURS FOR MAY 3-9 ARE: 
Saturday, May 3              closed 
Sunday, May 4                1:00 p.m. – 9:00 p.m. 
Monday, May 5              7:30 a.m. – 9:00 p.m. 
Tuesday, May 6              7:30 a.m. – 9:00 p.m. 
Wednesday, May 7         7:30 a.m. – 9:00 p.m. 
Thursday, May 8             7:30 a.m. – 5:00 p.m. 
Friday, May 9                 7:30 a.m. – 5:00 p.m. 
 
Please remember that there is 24/7 access to the library catalog and indexes & databases at 
http://www.msun.edu/infotech/library/index.htm 
 
If you are looking to read an entertaining story Tom Bedlam by George Hagen (PS3608.A36B44 2007) is a 
good one.  It follows the life of Tom Bedlam through growing up in the slums of London to his becoming a 
doctor and practicing in Africa.  It also has information and perspective on World War I.  Sometimes you laugh 
and sometimes you cry, but if you are looking for a good rainy day book—try this one. 
 
Computer Tip of the Week 
Outlook 2007 tip: Automatically Add Holidays 
By: Marianne Hoppe 

You can automatically add holidays to your Outlook calendar from virtually any country in the world. 
1.   On the Tools menu, click Options, and then click the Calendar Options… button on the 

Preferences tab. 

2.   On the Calendar options screen, click Add Holidays… button. 

3.   Select the check box next to each country/region whose holidays you want to add to your calendar, 
and then click OK (three times). 

To remove these holidays (“oops, wrong county!”): 
1.   On the View menu, click Current View and then Events. 

2.   Click on the column header Location to sort the list of events so that it displays all of the holidays 
for a country/region together. 

3.   Select the holidays you want to delete and click Delete. 

4.   Return to your normal calendar view by again selecting Current View from the View menu, and 
then Day/Week/Month. 

Tidbit  
By Bill Lanier 
 
Northern is now the fourth College or University in the United States to have a Polar Bear as their mascot. The 
others are: Bowdoin College, Brunswick, Maine (NCAA III), Ohio Northern University, Ada, Ohio (NCAA III) 
and University of Alaska Fairbanks (NCAA I & II).   Thus Northern will become the only NAIA school to 
currently have a Polar Bear as their mascot. 
 
Tidbit #2 
Tyson Thivierge is now the first Northern Alum to become the head wrestling coach at Northern. 
 



Dining Room Menu 
The Food Services weekly menu is available on line by visiting the Dining Hall page 
(http://www.msun.edu/stuaffairs/housing/dining.htm) or via the “MSU-N Food Services” channel in the Portal. 
 
Upcoming Events 
May 2 
Student Art Show FINAL DAY 
MAT performance "Divorce Southern Style" 8 p.m. Little Theatre 
Bowling Alley and Pin-n-Cue Recreation Area Open 5:00 PM - 9:00 PM 
 
May 3 
MAT performance "Divorce Southern Style" 8 p.m. Little Theatre 
 
May 5 
Spring Semester Finals Week  
Book Buy Back 8:00 AM - 1:00 PM 
 
May 6 
Spring Semester Finals Week 
Book Buy Back 8:00 AM - 1:00 PM 
 
May 7 
Spring Semester Finals Week 
Book Buy Back 8:00 AM - 1:00 PM 
 
May 8 
Spring Semester Finals Week 
Book Buy Back 8:00 AM - 1:00 PM 
 
May 9 
Alumni 50 Year Class Reunion 
Spring Semester Ends 
Spring Semester Finals Week  
Book Buy Back 8:00 AM - 1:00 PM 
Nurses Pinning Ceremony & Reception 1:00 PM - 4:00 PM 5th Ave. Christian Church 
MSUN Founders’ Excellence Awards 6:00 PM - 9:00 PM SUB 
 
May 10 
Alumni 50 Year Class Reunion 
Commencement 10:00 AM - 12:00 PM 
 
 
 
 


